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 Chapter 2: Introduction to SPRING 4 

2 Introduction to SPRING 4 
Welcome to SPRING 4, the latest version of the software system for groundwater model-
ling proven for more than 30 years. 

From underground mining to water supply, groundwater remediation and geothermics: 
SPRING's innovative software system provides optimal support for all your planning and 
consulting projects.  

The software system based on a development by the Ruhr University of Bochum allows 
you to calculate three-dimensional groundwater flow, surface water, heat and contaminant 
transport models.  

SPRING 4 in combination with the expert knowledge and experience of our staff is the 
basis for making your project a success. 

 

SPRING = Simulation of Processes in Groundwater 

 

 

 

2.1 SPRING - Performance Features 
 Finite Element method 

 Any combination of 1D, 2D and 3D elements possible 

 Interactive mesh generation with automatic mesh generation and mesh refining 

 Outflow layers in 3D models 

 Statistical calculation of fractures 

 Exact representation of geological structures by means of collapsing layers 

 Including tunnel structures in the calculation 

 Steady-state flow / transient flow calculations 

 Flow lines, calculation of path lines and travel times 

 Saturated / unsaturated flow, including calculation of the unconfined surface 

 Heat transport 

 Density-dependent flow 

 Contaminant transport, taking into account dispersion / diffusion, adsorption, produc-
tion, disintegration and decay 

 Transport of nuclide chains 

 Reactive contaminant transport 

 Simulation of flooding using box models 



4 CChapter 2: Introduction to SPRING 4 

 Automatic calibration methods (gradient method and inverse modelling) 

 Drainage flow (leakage, with limited amounts) 

 Special boundary conditions for geothermal calculations 

 Recharge calculation on the basis of a climatic soil water balance 

 Interface with the ArcInfo software system 

 Interactive control of the program sequence via SPRING'S graphic interface or via 
batch files 

 Extensive re-editing options of the displayed results with the display of bitmap (TIFF) 
files and output in DXF format 

 Automatic interpolation option of transient boundary conditions between the pre-
defined time steps 

 Output option for model data and calculation results in a freely selectable format as 
ASCII file. 

 Automatic calibration methods 

 Drainage balance, relative to the water body mesh 

 Statistical calculation of the basin area 

 

 

2.2 System Requirements 
 Windows 7, Vista, XP 

 512 MB RAM (2 GB recommended) 

 At least 300 MB available hard disk storage 

 Screen resolution 1024 x 768 (1280 x 1024 recommended) 

 

 

2.3 Installation 
 Close all open applications. 

 Insert the product CD or DVD into the appropriate drive of the computer. 

 As soon as the Autoplay screen appears, follow the instructions. 

 

Note: If the Autoplay screen is not loaded automatically, select "Computer" on the desktop, 
select the drive icon and finally the file "setup.exe". 

The number of computers in which the software may be installed can be found in the li-
cense agreement which forms part of the software. 
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2.3.1 SPRING Update 

Delta h makes software updates available for maintenance customers at intervals. You can 
download these updates conveniently via the delta h Download Centre. This requires an 
active Internet connection. 

 In SPRING 4, click at top right on the Help  Find Updates button. 

 Select Update and download it to your computer. 

 Follow the enclosed installation instructions. 

 

 

2.4 Program Start 
To start the software, click on Start – Programs – SPRING or, if you have created a desk-
top link, double-click on the corresponding icon: 

 

 

 

2.5 From Nature to the Model 

 

Fig. 1: From nature to the model 
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A groundwater model must be able to simulate real hydrogeological situations. To this end, 
first raw data such as groundwater measuring points and water level measurements, geo-
logical and topographic maps and other water management documentation must be col-
lected, and the problem under investigation must be formulated. 

From this follow the selection of the model boundaries and the aquifers to be included. 

This is where you start working with SPRING. 

 
Fig. 2: From the area boundary to the model area 

 

All raw data are read into SPRING by data export or digitisation and saved as structures. 
The structures are mesh-independent. The data can already be visualised at this point and 
subjected to a first inspection. 

Systematic building of the model using SPRING can be represented by the following 
schematic sequence: 

 

Data become Structures, 

mesh-relevant Structures become Contours, 

Contours become Nodes, 

Nodes become Elements. 

 

The nodes and elements of the finished FE mesh are assigned Attributes. 

 

 

2.5.1 Structures 

Structural data are points, lines and polygons, which, in addition to their geometric point 
information may also carry data information (attributes). A distinction is made between: 

 Point structures (zero-dimensional geometry)  

 Line structures (one-dimensional geometry)  

 Area structures (two-dimensional geometry)  
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Fig. 3: Structural types 

 

These structural types and the allocation of the corresponding information allow all data 
required for a groundwater model to be described, such as: 

 Point structures:  

 Coordinates of pumping wells and disposal wells 

 Coordinates of groundwater measuring points plus groundwater levels  

 Line structures  

 Polygon lines of the course of water course systems, including drainage levels or leak-
age coefficients or ex-/infiltration volumes  

 Building pit enclosure (sheet piling walls or seal walls) 

 Ditches, tunnels, navigation channels 

 Sewage and drainage systems  

 Area structures  

 Areas of different groundwater recharge 

 Areas of different soil characteristics or hydraulic parameters  

 Standing water (lakes or ponds) with and without overflow 

 Infiltration reservoir with amount of infiltration 

 

The structures (  ) can be created directly on-screen (e.g. on the basis of a topographic 
map) or imported from existing ASCII files (e.g. *.txt, *.csv, ARC/INFO generate format or 
*.dxf). The structure menu also offers extensive modification options.  

 

 

2.5.2 Contours 

Contours ( ) define all geometric constraint points and lines required when generating an 
FE mesh. They include, for example: 

 the outline of the area to be modeled,   
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 the geometric information required in the area, such as  

 the course of water courses,  

 the location of lakes and  

 the exact location of wells.  

 
Fig. 4: Contours of a model 

 

These constraint points and lines must be present as mesh nodes or element edges in the 
later FE mesh and combined in the contour.  

The basis of the contour are usually the structures and the required geometric constraint 
points during generation of the mesh The required components can be added by simply 
selecting them from the structural data (Contour  New  From Structure). 

A basic distinction is made between  

 I contours,  

 k contours  

 p contours  

 

I contours are contour lines on which later on element edges will be placed.   

k contours are the same lines as I contours, but are used for generating 1D fracture ele-
ments. They are generated using the program KLUFTI and contain, apart from the genera-
tion parameters provided for I contours, also the thickness and opening width of the 1D 
fractures. Moreover, k contours are also treated separately in boundary node generation.  

p contours are contour lines on which later on mesh nodes will be placed. 

The contours must be provided with parameters for further mesh generation (e.g. well pa-
rameters for exponential node generation around well nodes, maximum distances or divi-
sion points for long line contours). To do this, the Contour menu offers numerous options 
for editing and modification. 
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2.5.3 Nodes 

Once all contours have been adjusted, the nodes will be generated. In general, the follow-
ing sequence of node generation is recommended. 

 Node generation on the contours and perpendicular to the contours using 1-2 sections 
of the boundary node generator.  

 
Fig. 5: Boundary node generator 

 

 Generation of regular meshes in areas without contours 

 
Fig. 6: Boundary node generator 

 

 Generation of additional nodes by hand in the transition areas. 

Manual movement and deletion of nodes optimize node distribution. 
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2.5.4 Elements 

Once node generation has been completed in areas or globally, these nodes can be 
grouped (in areas or globally) by means of elements. The triangulation algorithm (advanc-
ing front) used in SPRING groups the nodes, first all triangular nodes. Then (if triangles 
and quadrangles are to be generated) suitable triangles are combined to quadrangles, in 
order to reduce the number of elements and thus the amount of calculation and memory 
required. 

After creating the elements, there are occasionally areas in which an unfavourable mesh 
structure becomes only visible after grouping the nodes. These areas can be re-edited by 
local mesh editing (deletion of areas and regeneration of nodes and elements, combining 
nodes or parts of quadrangles. SPRING's Mesh menu offers various methods of editing 
the mesh geometry. 

 
Fig. 7: Finished FE mesh 

 

 

2.5.5 Attributes 

Attributes contain all the data information that goes beyond the point information, such as 
material data, boundary conditions and auxiliary data.  

Once the generation of the mesh geometry is complete and has been inspected, the nodes 
and elements can be assigned attributes. On the basis of the structural data, data can be 
assigned in one of two ways: 

 Direct assignment: Node or element centres sufficiently close to the structure point 
containing the data information are assigned its value. 

 Assignment by interpolation: On the basis of "isolated" structure data points, values will 
be interpolated for the nodes or element centres of the corresponding structures lying 
in-between. 

 

Example: 
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The structure of a water course only contains water level information at the level measur-
ing points. Any number of additional nodes containing not a water level information are 
located between these data points. These nodes are assigned linearly interpolated values 
via Assignment by interpolation. 

Apart from assignment via structures, attributes can also be assigned to nodes or elements 
directly or statistically either individually or by area. 

All possible attributes are listed in chapter "Description of the data types" ( Data struc-
ture of the groundwater model). 

The structure of a horizontal groundwater model is described in detail in chapter "Structure 
of a 2D model". 

 

 

2.5.6 Calculation modules 

SPRING uses for the various calculations the following program modules: 

 Module for the model checking: DADIA  

 Module for the calibration: EICHEN   

 Module for the interpolation: INTERPOL  

 Module of the steady-state flow computation: GEONEU   

 Module of the transient flow computation: INSTAT  

 Module for the steady-state/transient flow and/or heat- or mass transport calculation 
and module for the inverse calibration: SITRA  

 Module for the plot generation: PLOGEO  

 Module for the data export: NACHLAUF 

 

The calculation modules of the flow calculation can be started in the SPRING user inter-
face via the menu item Calculation and are described in detail in the corresponding chapter 
"Calculations" (p. Fehler! Textmarke nicht definiert.). 

 

 

2.6 SPRING User Interface 
The SPRING 4 user interface consists mainly of 5 areas - menu bar, toolbars, main win-
dow, status bar and project manager. The range of functions of all areas depends on the 
currently open project type. If commands in a menu, in a view or at a certain point in the 
project are not available, they are shown in grey and are inactive or are not shown.   
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Fig. 8: SPRING User Interface 

 

 

2.6.1 Menu bar  

The menu bar gives access to most SPRING features: 

 

 

Upon selection of some menu commands, a submenu is displayed containing a list of addi-
tional options. Such menu commands have an arrow on the right of the command name 
pointing to the right. 

With some menu commands, a dialog box is displayed in which you have to enter more 
information for the command to be executed. These commands are marked with three 
suspension marks (…) following the name of the command. 

Some menu commands can be displayed directly by pressing a special key abbreviation or 
key combination (Ctrl+KEY). For commands that have been assigned a key abbreviation, 
the key abbreviation or key combination is shown on the right of the command. Thus, for 
example, the last action can be undone by pressing the key combination Ctrl+Z, and the 
last menu command can be repeated by pressing F12. 

 

Menu bar: 

 File The File menu is used to Open/Save/Finish projects, for data import/export, for 
adding/superimposing plots, for creating plots or for printing. 

 Edit The Edit menu is used to Restore/Undo editing steps, for project editing and for 
loading program options. 
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 View The View menu is used to Display/Hide layers/toolbars/3D displays and for creat-
ing vertical cuts. 

 Structure The Structure menu is used for creating and editing the structural data, for 
example reading in digital data on a line structure. 

 Contour The Contour menu is used for editing the contour elements.  

 Mesh The Mesh menu is used for creating and editing meshes, for example mesh 
generator. 

 Attributes The Attributes menu is used for editing data attributes, for example copying 
or calculating data types. 

 Layer The Layer menu is used for managing the graphic layers. 

 Object The Object menu is used for editing graphic objects, for example duplicating or 
moving individual objects. 

 Bitmap The Bitmap menu is used for editing or saving graphic files, for example tiff 
files. 

 Special features The Special features menu gives access to special program func-
tions for water meshes, transient program parameters, fractures or tunnels.  

 Calculation The Calculation menu is used to start SPRING's calculation tools. 

 Help The Help menu gives access to the program help and is used to start updates. 

 

 

2.6.2 Toolbars  

The toolbars (see figure below) contain buttons for quick access to the most important 
menu commands. The name of the command is displayed when the mouse pointer is 
placed over the button. 

The buttons of the toolbars are arranged in groups. In the View  Toolbars dialog box, you 
can set which toolbar groups you want to have displayed. These settings apply to the cur-
rent view and will be saved when the program is finished. The toolbar groups can also be 
dragged to a different position of the graphic user interface by clicking on the drag point on 
the left-hand side of the toolbar and moving it to the desired position while holding down 
the left mouse button. When the toolbar is dropped in the central area of the application 
window, it is undocked and shown freely floating; when the toolbar is dropped at the edge 
of the application window, the toolbar will be docked to this position. The following figure 
shows the toolbar "standard": 

 

 

The other toolbars are shown in chapter "SPRING-menus - View - Toolbars"  (p. Fehler! 
Textmarke nicht definiert.) . 
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2.6.3 Status bar 

The three-part status bar is located at the bottom edge of the application window (see fig-
ure). It shows the following information: (left) current input mode, (centre) world coordi-
nates of the mouse pointer, (right) information on menu commands and command buttons 
in the toolbars when placing the cursor over them. 

 

 

 

2.6.4 Main window 

The main window is used for creating, editing and visualizing element meshes and plots 
and is SPRING's centrepiece. 

 

 

2.6.5 Project manager 

The project manager is started by clicking on View  Additional windows  Project man-

ager or by selecting the symbol . It visualizes the arrangement of open Maps/Layers of 
the active project and their legends and allows easy manipulation of the Maps/Layers via 
drag&drop. 

A project is a collection of maps, layers, objects and other resources related to one another 
via a tree structure. At their specific level, they can be added in any number. An exception 
is the mesh editing mode, in which only one map is allowed. 

For example, the figure below contains a project named Witten.net with Map_0, which in 
turn is subdivided into various layers, for example mesh boundary, marks or elements. The 
GELA (ground level surface) layer is folded up and shows the legend of the isoareas 
shown in the main window. 

Only a single project can be open in the project manager. Upon creating a new project or 
opening an existing one, the project currently open in the project window will be replaced 
with the new one. 

After modifying a project, the project must be saved (by selecting the command File  

Save or the symbol ). 

The commands for Maps/Layers are available in the menu bar under the same names. 
The project manager makes some functions available in context menus (to open them, 
click on the appropriate entry) (see figure). 
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Fig. 9: Project manager in the mode model file 

 

In the project manager, Maps/Layers can be dragged to a different position (drag&drop). A 
layer can be dragged to a different map, but cannot be moved to a different layer. To de-
lete a selected layer, press the "Del" key. 

Maps and layers are "semantic folders" which do not constitute a logical file grouping and 
do not have to coincide with hierarchical organisation of files on your hard disk. 

Layers can correspond to physical files (e.g. tiff maps) located in your file system and are 
directly related to them. Layers of this type are displayed in the project window with their 
path specification. 

 

In the mode plot file, it is possible to edit the object of the individual layers (right mouse 
button). For example, it is possible to remove all polylines of a layer simultaneously, or the 
values of the object properties (defined before in the menu options) are assigned to all of 
the polylines. 
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Fig. 10: Project manager in the mode plot file 

 

2.6.6 Project information 

The project information window provides an overview of the most important project proper-
ties. 
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Fig. 11: Project information 

 

 

2.6.7 3D View 

The 3D view displays the element mesh opened in the mesh editing mode three-
dimensionally. 

Navigation: 

 Zoom Mouse wheel 

 Rotation Left mouse button + Movement of the mouse in the x or y direction 

 Shift Middle mouse button + Movement of the mouse in the x or y direction 

 z scaling Ctrl + mouse wheel 

 Reset Middle mouse button 
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The presentation can be changed with the help of the buttons of the toolbar in the main 
window (below). 

 

The element mesh, the element areas, the 1D-fractures, the mesh of 2D-fractures or the 
areas of the 2D-fractures can be displayed. The current 3D view can be exported as a 
bitmap. 

 

 

2.6.8 Vertical section 

In the mesh editing mode, the vertical section window shows a vertical section through the 
model with a straight line between two selected points. 
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Fig. 12: Vertical section 

 

 

2.6.9 Settings 

SPRING 4 can be configured by means of various settings and options. The settings are 
described in detail in chapter SPRING menus  Edit  Options. 

 

 

2.7 New functions 
In addition to the newly developed graphic user interface, changes have been made to 
individual menu items and various additional functions have been incorporated, which 
make working with SPRING very convenient. The most important changes are described in 
the following chapters.  

 

 

2.7.1 Newly developed graphic user interface 

The newly developed graphic user interface has the following advantages: 

 Full support of Microsoft Windows 7 

 Native support of 64-bit processors (Windows 64/Linux x64) 

 OpenGL support for 3D visualisation 

 Multi-language support 

 Internet update 

 Independently of Display Managers 
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Apart from the general advantages of program changes, SPRING's new user interface 
offers the following: 

 Merging of mesh and plot editing in a common interface 

 The new SPRING software presents itself with a completely newly developed interface. 
Merging mesh and plot editing allows short training periods and intuitive work se-
quences. 

 "Intelligent menus"  

 The available menu items adapt themselves to the current processing status by means 
of context-sensitive activation/deactivation.  

 Dialogs are predefined with "valid" max./min. values. Erroneous entries are automati-
cally corrected, if possible. 

 Transparent program windows 

 If desired, program windows can be displayed transparently, thus allowing the project 
to be viewed even when dialogs are open. The user can adjust the degree of transpar-
ency him-/herself    

 Dockable dialog windows and toolbars 

 Individual docking of dialog windows and toolbars allows the user interface to be ad-
justed to the task at hand. For a clear view of the working area, toolbars that are not 
required can be hidden. The arrangement is maintained, even after finishing SPRING, 
and is restored the next time the program is started. 

 Convenient mouse functions 

 Zooming with the mouse wheel and moving the project with the middle mouse button. 

 Buffered display 

 By buffering the frame buffer of the graphic card memory, the display is accelerated 
and a flickering screen avoided. 

 True WYSIWYG  

 The open document is now displayed during editing in exactly the same way as it looks 
when it is printed out or visualised in a graphics file. 

 Coordinate display in status bar 

 Permanent display of the world coordinates of the mouse pointer in the status bar. 

 A scale bar can be activated 

 The adaptive scale bar allows simple size comparisons during editing over all zoom 
levels. 

 Bookmarks for zoom sizes 

 Zoom sizes can be saved during a session for quick restore. 

 By drag&drop into the program window 
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 All files superimposable in SPRING (e.g. mesh files/plots/bitmap graphics/csv files) can 
be dragged into the program window by drag&drop and are superimposed on the map 
located below the cursor. 

 File history 

 Allows quick access to the documents opened last. 

 Undo/Redo for many actions 

 A large number of entries can be undone or restored in SPRING. Depending on the 
complexity of the action, no undo is possible or only a single-step undo up to the undo-
ing of all working steps is possible. 

 Shortcuts 

 Shortcuts for selected program functions. 

 Project information window 

 Visualizes the most important project parameters at a glance. 

 Project manager 

 Shows a clear arrangement of the map/layer structure of the open document in a tree 
structure and allows simple editing. Intuitive drag&drop allows adjustment of the se-
quence. Context menus (right click) allow quick access to the most important editing 
actions (e.g. copy/delete). By folding it open, further information can be displayed (e.g. 
legends), if required. 

 3D view/vertical section in the mesh editing mode 

 During mesh editing, the user has access to the 3D view and any positionable vertical 
sections, allowing possible mesh errors to be quickly detected.  

 2D/3D fracture visualisation 

 Fractures can be visualised both in 2D top view and in a 3D view. 

 2nd graphics system supports antialiasing and transparency effects 

 

 

2.7.2 New features in the individual menu items 

File 

 Import of partial meshes 

 The integration of partial meshes into a global mesh allows very large meshes to be 
edited, thus saving computer resources and allowing simple variant studies.      

 Direct bitmap graphic export 

 The current display in the program window can be saved at any time as a bitmap 
graphic (TIFF/JPEG).  

 Printing 

 Printing is possible at any time, not only in plot mode. 
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 Interface with Tecplot 

Selected or all model and result data can be exported to the Tecplot format for visuali-
sation. 

 Project modification 

 Closing the mesh no longer required. 

 Superimposing file 

 DXF/SHP files can now also be superimposed in the mesh editing mode.  

 File attachment 

 Files can now also be attached in plot mode on the left or at the bottom. 

 

Structures 

 Extensively parameterizable import of dxf/shp files 

 Structures can now be extensively parameterised and, if required, excluded prior to 
import from the dxf or shp format.  

 Intuitive structure list 

 The new structure list has been optimised for very large numbers of structures (e.g. 
following dxf import) and offers the user extensive sorting options. 

 Optimised selection tools 

 The selection tools have been improved and allow, apart from deselection by reselec-
tion, inversion of the selected area. 

 Quick generation of special structural geometries 

 Parallels to existing structures can be generated specifying distance and selecting the 
reference direction, as required, for example, for integrating seal walls. 

 Circular structures can be generated by simple parameterisation. 

 Automatic generation of a structure from the mesh boundary and the terrain surface 
(attribute GELA). 

 Structure coarsening in the area 

 Export of structures 

 Structure for water course system 

 When selecting the structure view, it can be selected according to the type of structure 
(line, point or area), without having to use a list. 

 New function: "Display structure texts"  

 New function: "Direction arrows" and their display size (zoon in direction arrow/zoom 
out direction arrow) are new 

 

Contours 

 Fracture contours 
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 Fracture contours (k contours) can now be generated and parameterised directly in 
SPRING. 

 

Mesh 

 Support for "Triangle" mesh generator 

 SPRING allows generation of element meshes using the external mesh generator Tri-
angle (by Jonathan Richard Shewchuk). For licensing reasons, it will be delivered as 
external binary and with source text.  

 Mesh refinement in the area of structures 

 Element meshes can be refined in SPRING also in the area of structures. 

 Additional function: 3D layer division 

 The "Layer division" function can now also be applied to several layers or to all layers 
simultaneously. 

 In addition, layers can now also be divided at a predefined height value. 

 

Attributes 

 Automatic correction of overlapping layers: 

 Node layers can now be checked for overlapping and the nodes merged automatically 
if needed (from top to bottom or opposite). 

 "Nearest Neighbour" interpolation method 

 SPRING has been extended by the "Nearest Neighbour" interpolation method. This 
method assigns each node or each element the value of its nearest neighbour. This 
method results in a "layered" appearance of the final result. Owing to its simplicity, the 
algorithm is extremely quick and plays out its strengths especially when digital ground 
models of very high resolution are assigned. 

 Advanced import options 

 SPRING offers the option to import calculation results from ongoing/aborted calculation 
runs. This allows errors to be detected and minimised already at the calculation stage. 
In addition to that, model data records can now also be imported from background 
files. 

 Export of attributes in the structure format 

 For simple further processing in the structure format, attributes can also be exported 
coordinate-related. 

 Visualisation of assigned hydrographs 

 Imported hydrographs can be conveniently displayed as a diagram during editing. 

 

Object 

 With immediate effect, objects can also be edited in the mesh editing mode. 
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Special features 

Although some of the tools available to the user are functional, at the present time some of 
them are still at the "experimental stage".  

 Water course system grouping related to the direction of flow  

 Automatic detection and grouping (incidence) of grouped water course systems. 

 Wizard functions for testing and adjusting the raw data with respect to the direction of 
flow. 

 Balancing of the exchange volumes between water course system and groundwater, 
taking into account the water resources. 

 Definition of the added (water treatment plant) and removed amounts (water works) at 
water course system nodes. 

 Determination of the water levels by simple parameterisation of the water course prop-
erties. 

 Improved handling of transient boundary conditions 

 Simple integration of fractures/tunnels in element meshes 

 SPRING offers tools for simple integration of constraint geometries such as tunnel 
constructions into three-dimensional element meshes, taking into account changes in 
topography and geological layers. This allows errors to be minimised when integrating 
fractures or tunnel constructions. 

 

Calculation 

 Completely newly designed interface of the calculation modules 

 Combination of the calculation modules 

 The calculation modules are combined, requiring the user first to decide which type of 
calculation (contaminant transport, density-dependent, heat…) is to be carried out. The 
abstract names (SITRA. GEONEU,...) have been integrated into the individual dialogs. 

 Interpolation using Kriging methods 

 Improvement in graphic processing during interactive generation of a variogram. 

 

Plot generation 

 Separation of the plot options 

 "Points" additional visualisation mode 

 Hydrograph plot using further dialog-based settings 

 Measured data can be displayed dialog-based as bar since SPRING 4 

 No limit to the measured/calculated data records to be plotted 
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Data Export 

 Separation of the individual data export options 

 Dialog-based data export in TECPLOT format 

 

Other 

 New help system 

 The new program help was compiled in the Microsoft CHM (Compiled HTML) format 
and allows convenient use, including a table of contents, keyword index and full text 
search function. 

 Central options dialog 

 The new options dialog allows configuration of all SPRING settings, including dialog-
based composition of colour charts.  

 Colour chart import in the Golden Software Surfer format 

 Colour charts can be imported in the Golden Software Surfer Colour Scale format. 
"Missing" colour values will be automatically interpolated. 

 

 

2.7.3 New features in the calculation modules 

Flow 

 Output of relative permeabilities 

 The calculated relative permeabilities can be read as result data. 

 Variable memory term calculation 

 Option to calculate the memory term via the van Genuchten parameters or porosity 
with variably saturated calculation 

 Accuracies (residual and iteration difference) can now also be predefined in GEONEU 
when using the iterative equation solver. 

 

Decay and production 

 Half-lives 

 Calculation of radioactive decay or biodegradation via the half-life. 

 Triangle function 

 When the material parameters are zoned, a triangle function for the decay or produc-
tion rate can be entered as additional 4th order function, which, after reaching a maxi-
mum, drops again until reaching the upper limit. This is followed by setting the decay or 
production to 0. 
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2.8 Help 
The complete documentation of the current SPRING version is available under Help. It is a 
browser-based system which can be accessed via Help  Manual. The help topics are 
updated with the update of the software, so that the latest information is always available. 

Important: The Online Help contains all information from the printed user manuals and 
additional information not available in printed form. A complete PDF version of the printed 
manual is contained on the product CD or DVD. The latest version is always available to 
download on our website spring.delta-h.de under Download&Support: Manual SPRING 4.1 
(EN).  

 

 

2.9 Support 
If you have concluded a maintenance agreement, you can contact your personal telephone 
support if you have questions on the installation or detect any product errors. Further in-
formation and contact addresses can be found in the Support area of the delta h website. 

 www.delta-h.de Telephone: 0049-2302-91406-0 

 email: dh@delta-h.de 

The Support area of the delta h website also contains information on troubleshooting and 
allows you to access the Support database, list of frequently asked questions (FAQ) and 
many more sources of information. Information on training courses/conferences for delta h 
products is also found on the website. 
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